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13. EQUILIBRIUM MODULE 
 

 

Fig. 1. Equilibrium Module Menu. 

 

This module enables you to calculate multi-component equilibrium compositions in 

heterogeneous systems easily. The user simply needs to specify the reaction system, with 

its phases and species, and gives the amounts of the raw materials. The program 

calculates the amounts of products at equilibrium in isothermal and isobaric conditions. 
 

The user must specify the substances and potentially stable phases to be taken into 

account in the calculations as well as the amounts and temperatures of raw materials. 

Note that if a stable substance or phase is missing in the system definition, the results 

will be incorrect. The specification can easily be made in the HSC program interface, and 

the input data file must be saved before the final calculations are made. 
 

The equilibrium composition is calculated using the GIBBS or SOLGASMIX solvers, 

which use the Gibbs energy minimization method. The results are saved in *.OGI or 

*.OSG text files respectively. The post-processing PIC-program reads the result files and 

draws  pictures  of  the  equilibrium configurations  if  several  equilibria  have  been 

calculated. The user can toggle between the equilibrium and graphics programs by 

pressing the buttons shown in Figs. 1, 4, 6 and 7. 

 

The Equilibrium module reads and writes the following file formats: 
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1. *.GEM-File Format 

This file format contains all the data and formatting settings of each definition 

sheet as well as the phase names, etc. The equilibrium module always saves this 

file regardless of which file format is selected for saving the actual input file for 

equilibrium calculations. If you want to use formatting settings, please use the 

Open Normal selection from File menu, see Fig. 4. 

1. *.IGI-file Format 

This file format contains the data for calculations for the GIBBS-solver only and it 

can read these files. 

1. *.ISG-file Format 

This file format contains the data for calculations with the Solgasmix-solver only 

and it can read these files. 

1. *.DA2-file Format 

This file format contains the data for calculations for the ChemSAGE 2.0 only. 

The  equilibrium module  also  reads  *.DA2-files,  but  not  if  solution  model 

parameters have been added to the file manually. Note that this equilibrium solver 

is not included in HSC 5.0. 

1. *.DAT-file Format 

This file format contains the data for calculations for ChemSAGE 3.0 and 4.0 

only. The equilibrium module also reads *.DAT-files, but not if solution model 

parameters have been added to the file manually. Note that this equilibrium 

program is not included in HSC 5.0. 

 

The equilibrium solvers GIBBS, Solgasmix and ChemSAGE deliver their results in 

ASCII text-files. The PIC-module reads these files and generates graphics and tables as 

described in Chapter 13.7. 

 

There are three ways of creating an input file (*.IGI, *.ISG): 
 

1. Press the top button in the menu, see Fig. 1. Then specify the elements which are 

present in your system, see Fig. 2. The HSC-program will search for all the 

available species in the database and divide them, as default, into gas, condensed 

and aqueous phases. The user can then edit this preliminary input table. 
 

1. Press the second button of the menu if you already know for sure the possible 

substances and the phases of the system, see Fig. 1. 

 

1. Press Edit Old Input File if you already have an input file which can be used as a 

starting file. Edit the input table and save it using a different name, see Fig. 1. 
 

If you only want to calculate the equilibrium compositions with the existing *.IGI-files 

press Calculate, see Fig. 1. If you want to draw pictures from the existing *.OGI files 
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made by the GIBBS-solver press Draw, see Fig. 1. Using Print you can get a paper copy 

of the *.IGI and *.OGI files. 
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13.1 Starting from defining the Elements  
 

 
 

Fig. 2. Specifying the elements of the system. 

 

If you do not know the substances of the system you may also start by specifying its 

elements, i.e. a selection of the system components. The elements selected will be 

displayed  in  the  Elements  Window,  see  Fig.  2.  After  pressing  Elements  in  the 

Equilibrium Menu, see Fig. 1, you can continue with the following steps: 

1. Select one or more elements: Press buttons or type the elements directly into the 

box. Try for example Ni, C, O, as given in Fig. 2. Do not select too many elements, 

to avoid a large number of species. In practice 1 - 5 elements is OK 

2. Select the form of species from Search Mode in which you are interested. You 

may specify up to 9 carbon limits for the organic species, for example 4, 6, 7. 

3. Press OK and you will see the species found, see Fig. 3. The HSC-program will 

search for all species which contain one or more of the elements given, first from 

the Own database and, if not found there, from the Main database. 

By decreasing the number of species you may increase the calculation speed and make 
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the solution easier. Therefore select only those species, which you are sure to be unstable 

in your system and press Delete Selected. Be careful, because if you delete the stable 

ones the calculated equilibrium results will be incorrect. If you are not sure of some 

substance then do not delete it. 

If you want to use only some of the species in the calculations then select only these and 

press Delete Unselected, which will remove the unnecessary species. 

Especially if you have selected C and/or H among the other elements you will get a very 

large number of species for the calculation and you are advised to decrease the number of 

species. See Chapter 13.4 for selection criteria for phases and species. 

 

 

Fig. 3. Deleting undesired species. 

 

If there are some odd species in the list then you can double click that formula in the list 

or press the Peep Database button and see the whole data set of the species in the 

database. If you want to remove it press Remove in the Database Window. This will 

remove the species from the list but not from the database. 

When making first time calculations it may be a good idea to take a paper copy of the 



 

      HSC Chemistry® 7.0   13 - 6 
 

Antti Roine     August 10, 2006     09006-ORC-J 
 

species selected by pressing Print. Then you can also easily add or delete species in the 

following window, see Fig. 4. 

The species have been divided into rough reliability classes in the database; you may 

select the species available in the most reliable class 1 by pressing Select Class 1. 

You may also set the sorting order for the species using the option buttons above the 

Continue button. The sorting order will determine the order of species in the Equilibrium 

Editor, see Fig. 4. 

When you have finished deleting the species, press Continue and you will return to the 

Equilibrium Editor window, see Fig. 4. 
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13.2 Giving Input Data for Equilibrium Calculations 
 

 

Fig. 4. Specification of the species and phases for the reaction system. 
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Fig. 5. Specification of the calculation mode. 
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The Equilibrium Editor consists of two sheets for determining the conditions of the 

equilibrium calculations. In Species and Options sheets, Figs. 4 and 5, you give all the 

data required to create an input file for the equilibrium solvers and for calculating the 

equilibrium compositions. Equilibrium calculations are made in three steps: 
 

1. The user gives the necessary input data using the Species and Options sheets in the 

Equilibrium Editor Window, Fig. 4, and saves this data as a text file. 
 

1. The equilibrium compositions will be calculated using the equilibrium solvers, 

which read the input-files and save the results in corresponding output-files. 
 

1. The results in the output-file can be further processed to graphical form by 

pressing Draw in Fig. 1 or 6 if several successive equilibria have been calculated. 
 

The most demanding step is the selection of the species and phases, ie. the definition of 

the chemical system. This is done in the Species sheet of the Equilibrium Editor, Fig. 4. 

You can move around the table using the mouse, or Tab and Arrow keys. The other 

things which you should consider are: 

1. Species (substances, elements, ions...) 
 

You may write the names of the species directly into the Species column, without a 

preliminary search in the Elements window. If you have made the search on the basis of 

the elements you already have the species in the Species column. 

You can check the names and the data of the species by pressing the right mouse button 

and selecting Peep Database from the popup menu. If you press the Insert button you 

can collect species for the equilibrium calculations sheet. Pressing Remove will remove 

an active species from the equilibrium calculations. 

You can insert an empty row in the table by selecting Row from the Insert menu or 

pressing the right mouse button and selecting Ins Row from the popup menu. 

Rows can be deleted by selecting Row from the Insert menu or by pressing the right 

mouse button and then electing Del Row from the popup menu. 

You can change the order of the substances by inserting an empty row and using the copy 

- paste method to insert substance in the new row. The drag and drop method can also be 

used. However, it is extremely important to move the whole row, because there is a lot 

of auxiliary data in the hidden columns on the right side of the sheet. 

Please keep the Copy Mode selection on in the Edit menu when rearranging species. 

This will force the program to select the whole row. When formatting the columns and 

cells, turn off the Copy Mode selection in the Edit menu. 

Use the (l)-suffix for a species only if you want to use the data of liquid phases at tempe-

ratures below its melting point. For example, type SiO2(l) if SiO2 is present in a liquid 

oxide phase at temperatures below the melting point of pure SiO2. See Chapter 28.2. 

 

2. Phases 
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The species selected in the previous step must be divided into physically meaningful 

phases as determined by the phase rows. This finally defines the chemical reaction 

system for the equilibrium calculation routines. Definition of the phases is necessary 

because the behavior of a substance in a mixture phase is different from that in pure 

form. For example, if we have one mole of pure magnesium at 1000 °C, its vapor 

pressure is 0.45 bar. However, the magnesium vapor pressure is much smaller if the same 

amount has been dissolved into another metal.  

The phase rows must be inserted in the sheet using Phase selection in Insert menu or 

using the same selection in the popup menu of the right mouse button. The Equilibrium 

module makes the following modifications to the sheet automatically when you insert a 

new phase row in the sheet and: 

1. Asks a name for the new phase, which you can change later, if necessary. 

2. Inserts a new empty row above the selected cell of the sheet with a light blue 

pattern. 

3. Assumes that all rows under the new row will belong to the new phase down to the 

next phase row. 

4. Inserts new Excel type SUM formulae in the new phase row. These formulae 

calculate the total species amount in the phase using kmol, kg or Nm3 units. 

When the insert procedure is ready, you may edit the phase row in the following way: 

1. The phase name can be edited directly in the cell. 

2. The phase temperature can also be changed directly in the cell and it will change 

the temperatures of all the species within the phase. 

3. Note that you can not type formulae to the amount column of the phase row, 

because the SUM formulae are located there. 

You can change the amount of species in a phase using kmol, kg or Nm3 units, 

simply by typing the new amount to the corresponding cell. The program will 

automatically update the total amount and the composition of the phase. 

The first phase to be defined is always the gas phase, and all gaseous species must exist 

under the gas phase row. Species of the same phase must be given consecutively one 

after another in the table. As default, HSC Chemistry automatically relocates all the 

gaseous species, condensed oxides, metals, aqueous species, etc. into their own phases if 

you start from the “give Elements” option, see Fig. 1. The final allocation, however, must 

be done by the user. 

If there is no aqueous phase, all aqueous species must be deleted. Note that if you have 

an aqueous phase with aqueous ions, you must also have water in the phase ! 

If you expect pure substances (invariant phases) to exist in the equilibrium configuration, 

insert them as their own phases by giving them their own phase rows or insert all these 

species under the last phase row and select the Pure Substances in the Last Phase 

option, see Fig. 5. Formation of pure substances is possible especially in the solid state at 

low temperatures. For example, carbon C, iron sulfide FeS2, calcium carbonate CaCO3, 

etc. might form their own pure phases. 

One of the most common mistakes is to insert a large amount of relatively “inert” subs-

tance to the mixture phase. For example, large amounts of solid carbon at 1500 °C do not 



 

      HSC Chemistry® 7.0   13 - 11 
 

Antti Roine     August 10, 2006     09006-ORC-J 
 

dissolve into molten iron. However, if these both species are inserted into the same phase 

then the equilibrium program assumes that iron and carbon form an ideal mixture at 1500 

°C. This will, for example, cause much too low vapor pressure for the iron. Therefore 

carbon should nearly always be inserted into its own phase at low temperatures. 

 

3. Input Temperatures of the Species 
 

Input temperatures for the raw material species are essential only in the equilibrium heat 

balance calculations, i.e. if you provide some input amount for a species you should also 

give its temperature. The input temperature does not affect the equilibrium composition. 

You may select the temperature unit by selecting C from the Units menu, see Fig. 4. 

 

4. Amount of the Species 
 

In this column you give the input amounts of the raw material species. The most 

important thing for the equilibrium composition is to give the correct amounts of 

elements to the system. You may divide these amounts between the species as you like. 

If the correct heat balance is required, you must divide the amounts of elements exactly 

into the same phases and in a similar manner as in the real physical world. 

You may choose between kmol or kg/Nm3 units by selecting mol or kg from the Units 

menu. Note that kilograms refer to condensed substances and standard cubic meters 

(Nm3) to gaseous substances, see Fig. 4. 

 

5. Amount Step for Raw Materials 
 

If you wish to calculate several successive equilibria you give an incremental step for one 

or  more  raw material  species.  Then the  programs automatically calculate  several 

equilibria by increasing the amount of this species by the given step. Please remember to 

select the Increase Amount option, see Fig. 5, and give also the number of steps. The 

maximum number of steps which can be drawn is 251 for the GIBBS solver and 50 for 

Solgasmix solver. Some 21 - 51 steps are usually enough to give smooth curves to the 

equilibrium diagram. 

You may give step values for several species simultaneously. For example, if you want to 

add air to the system give a step value for both O2(g) and N2(g). Please do not forget to 

specify the number of steps, if a diagram is to be drawn from the results. 

 

6. Activity Coefficients (in Gibbs-solver) 
 

The simple definition of Raoultian activity is the ratio between vapor pressure of the 

substance over the solution and vapor pressure of the pure substance at the same 

temperature. 
 

a = p(over solution) / p(pure)   [1] 
 

Activity coefficient describes the deviation of a real solution from an ideal mixture. 

Activity coefficient f is defined as the ratio between activity a and mole fraction x of the 

species in the mixture. 
 

f =  a / x    [2] 
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In an ideal solution they are therefore defined as a = x and f = 1. As a default in 

GIBBS and SOLGASMIX, the activity coefficient of a species in the mixture phases 

is always 1. However, if non-ideal activity coefficients are available they may be 

introduced in the right column. Only simple binary or ternary expressions can be utilized 

directly by the GIBBS solver within HSC, such as: 
 

Ln(f)   =  8495/T-2.653 

Ln(f)   =  0.69+56.8*X24+5.45*X25 

Ln(f)   =  -3926/T 

Ln(f)   =  -1.21*X7^2-2.44*X8^2 

where: 

T  =  Temperature in K 

X24  =  Mole fraction of the species with a row number 24 in the sheet. 

f  = Activity coefficient. 

Formulae are written using the same syntax as in Excel, the defined names T and P are 

available for temperature and pressure. Mole fractions are given as cell references to 

column X. Please note that the returning values of the formulae are insignificant, because 

the mole fraction values in column X are zero, see Figs. 16 - 17. 

 

7. Heading 
 

You may add any kind of heading for the input file, see Fig. 5. The maximum number of 

characters allowed in the heading is 80. The PIC post-processing program automatically 

adds the heading to the diagrams, see Figs. 11 and 17. 

 

8. Equilibrium Temperature 
 

Equilibrium will be calculated at this temperature, and each equilibrium is isothermal 

and thus has a constant temperature throughout the system, see Fig. 5. You may also give 

the temperature range if you wish to calculate several sequential equilibria. Please 

remember to also select the Increase Temperature option and give the Number of 

Steps, see Fig. 5. Several equilibria are needed in order to create graphics from the 

results. 

Temperatures  in  the  Species  Sheet,  Fig.  4,  have  no  effect  on  the  equilibrium 

compositions. They are only needed if the reaction enthalpy is necessary to calculate 

correctly, see Chapter 13.7.1, Fig. 10 and Y-Axis selections. 

 

9. Equilibrium Pressure 
 

Equilibrium calculations are always made in constant pressure or in isobaric conditions. 

Normally a total pressure of 1 bar is used, and it is also given as default in HSC. In 

autoclave or vacuum furnace applications you may need to change the pressure. You can 

also increase pressure incrementally by giving a Pressure Range, please remember to 

also define the Increase Pressure option for this selection, see Fig. 5 

The total pressure P° has effect on gas phase activity values ai in formula 3. The fugacity 
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Fi of gas species i may be calculated from this value with formula 4. 
 

ai =  P° * xi   [3] 
 

Fi =  ai  * 1 bar   [4] 

 

10. Number of Steps 
 

If you have defined increments (steps) for raw material species or specified a temperature 

or a pressure range then you should also give the Number of Steps required, see Fig. 5 

The maximum number of steps in Gibbs solver is 251 and for Solgasmix the maximum 

available is 51. Usually 21 - 51 steps give quite smooth curves in the equilibrium 

diagram. A large number will  only give more points to the picture and a longer 

calculation time. 

If you have given an amount step for a raw material species, the calculations should be 

made using an increasing species amount. If you have given a temperature or pressure 

range, then the calculations should be made by increasing the temperature or pressure. 

No simultaneous increments in composition, temperature and pressure are allowed. 

Please do not forget to select the correct increase option, see Fig. 5 

 

11. Criss-Cobble and Mixing Entropy of Aqueous Species 
 

HSC will utilize Criss-Cobble extrapolation for the heat capacity of aqueous species at 

elevated temperatures (> 25 C) if the Criss-Cobble option is selected, Fig. 5 Refer to the 

details in Chapter 28.4. Note that: 

A) It  is  necessary  to  select  the  Mixing  Entropy  option  for  the  GIBBS  and 

SOLGASMIX routines. In this case, the activities of the results will be presented 

on the Raoultian scale which is based on mole fractions, see Chapter 13.3. 

B) It is not recommended to select the Mixing Entropy option for the ChemSAGE or 

for the SOLGASMIX if the conventional activity coefficients of aqueous species 

are to be given in the FACTOR subprogram. 

If the Criss-Cobble and Mixing Entropy options are not selected for the GIBBS or 

SOLGASMIX programs, then the activity coefficients of aqueous species may be set to 

55.509/X(H2O), which will convert the Raoultian activity scale to the aqueous activity 

scale. This trick will also give the activities of the results on an aqueous scale, where the 

concentrations units are expressed as moles per liter of H2O (mol/l). 

 

12. GIBBS, SOLGASMIX and ChemSAGE File Format 
 

With  this  option  you  can  select  the  input  file  formats  accepted  by the  GIBBS, 

SOLGASMIX3 or ChemSAGE4 Gibbs energy minimization routines, Fig. 5 

If you save the file in GIBBS format you can carry out the calculations in HSC 

Chemistry with the GIBBS-solver by pressing Gibbs. If you have selected SOLGASMIX 
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format you can carry out the calculations with a modified SOLGASMIX-solver by 

pressing SGM, see Fig. 5 ChemSAGE is a separate software product, which is not 

included in the HSC Chemistry package. 

Note: the activity coefficients and formulae specifications, see Fig. 4 are valid only in the 

GIBBS-solver. Non-ideal mixtures for SOLGASMIX and ChemSAGE must be defined 

separately. 

 

13. Pure Substances (“Invariant phases”) 
 

The SOLGASMIX and ChemSAGE solvers require information on the number of pure 

substances defined in the system. The internal name for pure substances in the programs 

is the invariant phase, referring to the fixed or invariant composition of a pure substance. 

All species in the last substance group can be set to be pure substances with the Pure 

Substances in the Last Phase option, see Fig. 5 

 

14. File Save and File Open 
 

You must first save the input data for the calculations, see Figs. 4 and 5. When this is 

done you may activate the equilibrium program and carry out the calculations. With 

File/Open you can read an old input file for editing. Note that from File menu you can 

easily select file types for Open and Save. Note also that the *.IGI, *.ISG and *.DAT file 

types do not save edited phase names and formatting settings. The Equilibrium module 

always saves automatically a *.GEM file which can be used to return these settings. 

 

15. Exit 
 

If you want to return to the previous menu press Exit. Remember, however, to save your 

input data first ! 
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13.3 Aqueous Equilibria 

 

Equilibrium calculations of aqueous solutions can be made in a similar manner as 

presented previously for non-electrolyte solutions. However, some points need special 

attention (see also Chapter 28.4 for information of aqueous species): 

1. Always remember to add water to the aqueous phase. For example, 55.509 mol (= 

1 kg) is a good selection if the amount of ions is some 0.01 - 5 moles. 

2. Add some charged species (electrons) to the system, for example, by 0.001 mol 

OH(-a)  and the same amount  of  H(+a).  Be sure to maintain the electronic 

neutrality of the system if you will carry out the calculations with the Gibbs solver. 

3. If you are calculating, for example, the dissolution of 1 mole of CaCO3 into water 

and you have stoichiometric raw material amounts, please also add a small amount 

of O2(g) to the gas phase, for example, 1E-5 moles. If you have stoichiometric 

NaCl in the system please add a minor amount of Cl2(g) to the gas phase (1E-5 

mol).  These  tricks  help  the  GIBBS and  SOLGASMIX  solvers  to  find  the 

equilibrium composition in cases of fully stoichiometric overall compositions. 

4. HSC converts the entropy values of aqueous components from the molality scale 

to  mole  fraction  scale  if  the  Mixing Entropy  option  is  selected,  Fig.  33. 

Therefore, the entropy values in the input files are not the same as in the HSC 

database. Identical results will be achieved if the Raoultian activity coefficients of 

the aqueous species are changed to 55.509/X(H2O) which converts the Raoultian 

activity scale to the aqueous activity scale. 

5. For some aqueous species only G values are available at 25 °C. These can be saved 

in the database as H values if S = 0. Note, however, that these can only be used in 

the calculations at 25 °C. 
 

1. You may check the equilibrium results by doing simple element balance checks or 

comparing  the  equilibrium  constants.  For  example,  you  can  calculate  the 

equilibrium constant for reaction 18 using the Reaction Equations option at 25 C, 

see Fig. 12: 

 

H2O = H(+a) + OH(-a) K = 1.020E-14  [5] 

 

You may also calculate the same equilibrium constant from the equilibrium results 

of the GIBBS program using equation 10 in Chapter 8. Introduction. You can read 

the necessary molal concentrations, for example, from the equilibrium results 

\HSC3\CaCO3.OGI file, see Table 1. This calculation should give nearly the same 

results as the Reaction Equation option. 

 

[H(+a)] * [OH(-a)]  4.735E-13 * 2.159E-2 

K  =      =   = 1.023E-14 [6] 

[H2O]   55.468/55.509 
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INPUT AMOUNT EQUIL AMOUNT MOLE FRACT  ACTIVITY  ACTIVITY 

PHASE 1:   mol         mol               COEFFICI 

N2(g)   1.0000E+00  1.0000E+000  9.683E-01  1.00E+00  9.683E-01 

H2O(g)   0.0000E+00  3.2678E-002  3.164E-02  1.00E+00  3.164E-02 

O2(g)   1.0000E-05  1.0000E-005  9.683E-06  1.00E+00  9.683E-06 

CO2(g)   1.0000E-03  1.5986E-013  1.548E-13  1.00E+00  1.548E-13 

Total :   1.0010E+00  1.0327E+000  1.000E+00 

 

PHASE 2 :    MOLE FRACT 

H2O   5.5500E+01  5.5468E+001  9.994E-01  1.00E+00  9.994E-01 

CO3(-2a)  0.0000E+00  4.7507E-007  8.560E-09  1.00E+00  8.560E-09 

C2O4(-2a)  0.0000E+00  8.0560E-061  0.000E+00  1.00E+00  0.000E+00 

Ca(+2a)   1.0000E+00  1.0797E-002  1.945E-04  1.00E+00  1.945E-04 

CaOH(+a)  0.0000E+00  1.4656E-010  2.641E-12  1.00E+00  2.641E-12 

H(+a)   0.0000E+00  4.7348E-013  8.531E-15  1.00E+00  8.531E-15 

HCO2(-a)  0.0000E+00  8.1514E-048  0.000E+00  1.00E+00  0.000E+00 

HCO3(-a)  0.0000E+00  4.9071E-009  8.842E-11  1.00E+00  8.842E-11 

HO2(-a)  0.0000E+00  1.1549E-020  2.081E-22  1.00E+00  2.081E-22 

OH(-a)   2.0000E+00  2.1593E-002  3.890E-04  1.00E+00  3.890E-04 

Total :   5.8500E+01  5.5501E+001  1.000E+00 

 

Table 1. A part of the equilibrium result file \HSC5\GIBBS\CaCO3.OGI. 
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13.4 General Considerations 
 

Although equilibrium calculations are easy to carry out with HSC Chemistry, previous 

experience and knowledge of the fundamental principles of thermodynamics is also 

needed. Otherwise, the probability of making serious errors in basic assumptions is high. 

There are several aspects, which should be taken into account, because these may have 

considerable effects on the results and can also save a great deal of work. For example: 

 

1. Before any calculations are made, the system components (elements in HSC 

Chemistry) and substances must be carefully defined in order to build up all the 

species and substances as well as mixture phases which may be stable in the 

system.  Phase  diagrams  and  solubility  data  as  well  as  other  experimental 

observations are often useful when evaluating possible stable substances and 

phases. 

2. Defining all the phases for the calculation, which may stabilize in the system, is as 

important as the selection of system components. You may also select a large 

number of potential phases just to be sure of the equilibrium configuration, but it 

increases  the  calculation  time and  may also cause problems in finding the 

equilibrium.  

3. The definition of mixtures is necessary because the behavior of a substance 

(species)  in  a  mixture  phase  is  different  from that  in  the  pure  form.  The 

microstructure or activity data available often determines the selection of species 

for each mixture. Many alternatives are available even for a single system, 

depending on the solution model used for correlating the thermochemical data. 

Note: the same species may exist in several phases simultaneously; their chemical 

characters in such a case are essentially controlled by the mixture and not by the 

individual species. 

1. If you expect a substance to exist in the pure form or precipitate from a mixture as 

a pure substance, define such a species in the system also as a pure (invariant) 

phase. This is often a valid approximation although pure substances often contain 

some impurities in real processes. All species in the last phase can be set to be 

pure substances using the Pure Substances in the Last Phase option, see Fig. 5 

2. The raw materials must be given in their actual state (s, l, g, a) and temperature if 

the correct enthalpy and entropy values for equilibrium heat balance calculations 

are required. These do not affect the equilibrium compositions. 

3. Gibbs  energy  minimization  routines  do  not  always  find  the  equilibrium 

configuration. You may check the results by a known equilibrium coefficient or 

mass balance tests. SOLGASMIX provides a note on error in such cases. It is 

evident that results are in error if you get random scatter in the curves of the 

diagram, see Figs. 11, 17 and 19. You can then try to change species and their 

amounts as described in Chapter 13.2 (2. Phases, 4. Amount of Species). 
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4. Sometimes when calculating equilibria in completely condensed systems it is also 

necessary to add small amounts of an inert gas as the gas phase, for example, Ar(g) 

or N2(g). This makes calculations easier for the equilibrium programs. 

5. It may also be necessary to avoid stoichiometric raw material atom ratios by 

inserting an additional substance, which does not interfere with the existing 

equilibrium. For example, if you have given 1 mol Na and 1 mol Cl as the raw 

materials and you have NaCl as the pure substance, all raw materials may fit into 

NaCl due its high stability. The routines meet difficulties in calculations, because 

the amounts of all the other phases and species, except the stoichiometric one, go 

to zero. You can avoid this situation by giving an additional 1E-5 mol Cl2(g) to the 

gas phase, see Fig. 46. 

6. Quite often the most simple examples are the most difficult ones for the Gibbs 

energy minimization routines due to matrix operations. However, the new GIBBS 

4.0 version usually finds the solution for the simple systems too, such as the two 

phase H2O(g) - H2O -system between 0 - 200 °C. 

7. Sometimes a  substance is very stable thermodynamically,  but its  amount in 

experiments remains quite low, obviously due to kinetic reasons. You may try to 

eliminate such a substance in the calculations in order to simulate the kinetic 

(rate) phenomena, which have been proven experimentally. 

8. It is also important to note that different basic thermochemical data may cause 

differences to the calculation results. For example, use of HSC MainDB4.HSC or 

MainDB5.HSC database files may lead to different results. 

The definition of phases and their species is the crucial step in the equilibrium 

calculations and it must be done carefully by the user. The program is able to remove 

unstable phases and substances, but it can not invent those stable phases or species which 

have not been specified by the user. The definition of phases is often a problem, 

especially if working with an unknown system. 

Usually it is wise, as a first approximation, to insert all gas, liquid and aqueous species in 

their own mixture phases, as well as such substances which do not dissolve into them, for 

example, carbon, metals, sulfides, oxides, etc. in their own invariant phases (one species 

per phase), according to basic chemistry. If working with a known system it is, of course, 

clear to select the same phase combinations and structural units for the system as found 

experimentally. These kinds of simplifications make the calculations much easier and 

faster. 

The user should give some amount for all the components (elements) which exist in the 

system for Gibbs solver. However, Solgasmix solver is also able to reduce the number of 

components (elements) automatically if a component is absent in the raw materials. 

It is also important to understand that due to simplifications (ideal solutions, pure phases, 

etc.) the calculations do not always give the same amounts of species and substances as 

found experimentally. However, the trends and tendencies of the calculations are usually 

correct. In many cases, when developing chemical processes, a very precise description 
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of the system is not necessary and the problems are often much simpler than, for 

example, calculation of phase diagrams. 

For example, the user might only want to know at which temperature Na2SO4 can be 

reduced by coal to Na2S, or how much oxygen is needed to sulfatize zinc sulfide, etc.: 

The Na2SO4.IGI example in the \HSC5\GIBBS directory shows the effect of temperature 

on Na2SO4 reduction with coal; the same example can be seen also in the HSC color 

brochure, page 3. The calculated compositions are not exactly the same as found 

experimentally, but from these results we can easily see that at least 900 C will be needed 

to reduce the Na2SO4 to Na2S, which has also been verified experimentally. 

The real Na-S-O-C-system is quite complicated. In order to describe this system precisely 

from 0 to 1000 C, solution models for each mixture phase would be needed to describe 

the activities of the species. Kinetic models would also be necessary at least for low 

temperatures. To find the correct parameters from the literature for all these models 

might take several months. However, with HSC Chemistry the user can get preliminary 

results in just minutes. This information is often enough to design laboratory and 

industrial scale experiments. 
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13.5 Limitations 
 

The present  version of  the GIBBS program has no limitations as to numbers of 

substances and phases because it uses dynamic arrays. However in practice, 3 - 250 

species and 1 - 5 phases are suitable numbers to carry out the calculations within a 

reasonable time. 

 

Although the maximum number of rows in the spreadsheet editor used in Fig. 4 is 16384, 

the practical maximum number of species is much smaller. The maximum number of 

equilibrium points, which can be drawn on the Equilibrium diagram, is 251. However, a 

much smaller number of equilibrium points usually give smooth curves to the diagram. 

 

The modified SOLGASMIX provided in the HSC package has the following limitations: 

- maximum number of components    20 

- maximum number of mixtures    31 

- maximum number of pure substances (“invariant phases”)   30 

- maximum number of species in the mixture phases  150 

- maximum number of Cp ranges in input files  7 

- SGM neglect phase transitions < 298.15 K  

 

The most important limitation of the old GIBBS 2.0 was that, in some cases, only one 

pure substance was allowed. Otherwise the program provided unpredictable results. If 

pure substances (invariant phases) do not, however, contain the same elements, several of 

them are usually accepted. You can avoid this limitation by putting a minor amount of 

dissolving species into such a pure substance and defining it as a solution phase. In any 

case, the new GIBBS 5.0 is much more reliable in these situations. 

 

At least a tiny amount for all elements defined in the system must be given as input if 

you use the GIBBS routine. For example, if you have any Fe-containing species in the 

system, you must also give some Fe to the raw materials. 

 

SOLGASMIX  can  handle  systems  with  several  pure  substances  usually  without 

difficulty. It also can calculate equilibria in systems smaller than originally defined in 

HSC. The SOLGASMIX routine can therefore treat systems with less components than 

defined in its input file and thus a certain system component may be absent in the raw 

materials. 

 

The SOLGASMIX provided with the HSC package is a modified version of the original 

code from the University of Umeå, Sweden. The modification allows the use of grams as 

input and in this case the result is given both in molar fractions and moles as well as in 

weight percentages and grams. The input file has therefore additional rows for each 

system components (elements). The locations and contents of these rows can be found in 

the input file listing in Chapter 14. Equilibrium samples. 

 

If you have an aqueous phase with ionic species you should also be sure to maintain 

electric neutrality in the system, because the GIBBS solver treats electrons in the same 

way as elements. SOLGASMIX can usually handle a small deviation from the electron 

neutrality. 
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13.6 Calculation Routines 

13.6.1 GIBBS Equilibrium Solver 

 

Fig. 6. GIBBS equilibrium solver. 

 

 

Equilibrium calculations  in  the  GIBBS routine are  made using the Gibbs energy 

minimization method. The GIBBS program finds the most stable phase combination and 

seeks the phase compositions where the Gibbs energy of the system reaches its minimum 

at a fixed mass balance (a constraint minimization problem), constant pressure and 

temperature. This method has been described in detail elsewhere5. 

 

Operation Instructions: 

1. Select *.IGI file for calculations by pressing File Open, if the file is not already 

selected. 

2. Use  previous  results  as  the  initial  guess  option  will  slightly  speed  up 

calculations, but it is recommended to disable this option, because sometimes 

GIBBS does not give valid results with this option. The default setting is off. 

3. Fast calculations option will speed up the calculations - the default value is on. 

4. Press Calculate and wait for the All Calculated message. 

5. Press Draw Diagram if you want the results in graphical form. 
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6. Press Exit to return to HSC. 

Advanced options belong to properties not supported yet, these may be available in the 

next HSC version as tested and supported form. 

 

13.6.2 SOLGASMIX Equilibrium Solver 
 

 
 

Fig. 7. Message box of the SOLGASMIX program. 

 

 

The SOLGASMIX equilibrium routine has been integrated in the HSC Chemistry 

package in a different way to the GIBBS routine, because it is not a Windows-based 

program. No own icon is provided, but the program has been connected with the HSC 

interface through a direct data link using files. 

 

The SOLGASMIX routine uses a similar Gibbs energy minimization calculation method 

as the GIBBS program. All its mixture phases can be defined as non-ideal mixtures in the 

FACTOR subroutine, but this option is not supported by HSC interface. For further 

reference,  the  original  input  guide  and  the  thesis  of  Gunnar  Eriksson should be 

consulted6. 

 

The original SOLGASMIX code has been modified to accept grams instead of moles as 

input amounts. The equilibrium composition in the gram mode is given both as a 

conventional  table  with moles  and mole fractions and also as  grams and weight 

percentages. The alterations in the input files due to this modification can be found in 

Chapter 14. Equilibrium samples. 

 

SOLGASMIX can also be activated in the HSC directory as an independent, stand-alone 

equilibrium solver. In this case, its input file name created in HSC must be defined as 

INPUT. The equilibrium calculations results will be stored with the file name RESULT. 

Equilibria calculated as a function of temperature, pressure or other process variables can 
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be later post-processed to graphics using the PIC-module by HSC Chemistry. 

 

You may run SOLGASMIX by pressing SGM when SGM format has been selected, see 

Fig. 5, or by selecting Solgasmix in the Calculate menu. Wait for the calculations until 

Draw Diagram is activated, see Fig. 7. After calculations you can draw a diagram from 

the results by pressing Draw Diagram or return to Equilibrium Window by pressing 

Exit. 
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13.7 Drawing Equilibrium Diagrams 
 

 
 

Fig. 8. Selecting the x-axis for an Equilibrium Diagram. 
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Fig. 9. Selecting the x-axis for an Equilibrium Diagram. 
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The PIC post-processor draws diagrams on the basis of the output files of the GIBBS 

program (*.OGI-files), as well as from the SOLGASMIX (*.OSG) and ChemSAGE 

(*.RES) result files. These diagrams can be drawn, for example, as a function of a 

specified reactant amount or equilibrium temperature. Start the PIC program by pressing 

Draw in Fig. 6 or 7 and follow these instructions: 

1. Select the *.OGI file for diagram by pressing File Open if not yet selected, see 

Fig. 8. This file contains the results of the equilibrium program. 

2. Select the species or temperature for the x-axis by clicking the desired item in the 

list box using the mouse. The program shows the recommended selection with an 

arrow, which is the variable used in the calculations, see Fig. 8. 

3. Press OK. 

4. Select the species for the y-axis by keeping Ctrl Key down and clicking with the 

mouse. Sometimes it is convenient to select only those species, which contain the 

same element, for example Ni, for one diagram. This can easily be done using the 

element list, see Fig. 9. In standard cases you can get more illustrative diagrams by 

drawing all gaseous species on one diagram and all other species on another. 

The number  of  selected species  is  not  limited.  All  species included in the 

calculation can be selected to the diagram. 

1. Press OK. 

2. Note: You can return to HSC by pressing Cancel or Exit. 
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13.7.1 Selecting Data Type for the X- and Y-axis 
 

 
 

Fig. 10. Selecting data type for the x- and y-axis. 

 

In this menu you can select the data type for the diagram. Usually you may accept the 

default selections by pressing Diagram, but the output may be modified. For example, 

you can draw the composition of a gas phase by clicking Equilibrium Compositions 

option for the y-axis instead of Equilibrium Amount. All the species in one phase must 

be selected if composition of this phase will be drawn to the diagram. 

If you are working with an aqueous system you will get a pH option for the X - Axis. 

This option will draw the results as a function of pH. 

By pressing Species you will return to the previous window, see Fig. 9. 

If you only want the results in tabular format, press Table. 

You can also sort the species in descending order, or leave them in the original order 

using Sorting Order of Species option. This selection will determine the order of 

species in the results table. 

Temperature and amount units may be selected using the Temperature and Amount 

options. 

The number of species is not limited, and all the species included in the equilibrium 

calculations can be selected to the diagram. 
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13.7.2 Result Graphics (Equilibrium Diagram) 
 

 
 

Fig. 11. Equilibrium Diagram. 

 

When you press Diagram in the Axis menu, Fig. 10, then the PIC post-processor module 

reads the equilibrium results from the file and draws the diagram using default scale, 

font, line width, etc. selections, see Fig. 11. Note that the program inserts the species 

labels automatically above the maximum point of the curve using the same color for the 

curve and label. If the line is not within the selected x- and y-range or it is on the border 

then the program will not draw the line or the label. 

You can edit the diagram, Fig. 11, by using several formatting options: 

1. Double click the x- or y-scale numbers or select X-Axis or Y-Axis from the 

Format menu to change, for example, the minimum and maximum values of the 

X- and Y-axis, see Fig. 12. In some cases it is also advantageous to change the y-

axis to logarithmic scale in order to display the large variations in amounts or 

concentrations. 

From the same window you can change the number format of x- and y-axis 

numbers as well as their font size, color, etc. 
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1. When the scales are OK, you can relocate any label (species, x- and y-axis 

heading, etc.) by mouse using the drag and drop method. First select the label, 

keep the left mouse button down and drag the label to a new location, release the 

mouse button and the label will drop. 

2. The line width of curves, species label font, etc. may be changed by double 

clicking the species labels or selecting the label with mouse and selecting Format 

Label from the menu. You cannot do this by double clicking the line. The label 

and curve editing window is shown in Fig. 13. Note that other line styles than solid 

are available only for line widths smaller than 0.3 mm. 

 

Fig. 12. Changing scales, scale number format and font settings. 
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Fig. 13. Changing label and line specifications. 

4. You can edit any label and heading on the screen by simply clicking the text in the 

label by mouse and starting to edit. For example you can change the label “Ni” to a 

non-abbreviated form “Nickel”. 

5. You can create new labels by selecting Label from the Insert menu. These new 

labels can be deleted using the Label selection in the Delete menu. Default labels 

cannot be deleted, and the only possibility is to remove all text from them. 

6. The first time you use HSC Chemistry it may be necessary to change the default 

fonts by selecting the Default Font from the Format menu, because the available 

fonts vary from one computer to another. Usually Times New Roman, bold, size 

11 font is a good selection. The selection will be automatically saved in the 

HSC.INI-file in your Windows directory. 

7. When you are satisfied with the diagram you can print it by pressing Print B&W. 

If you have a color printer press Print Col. The print dialog gives several useful 

options for a hard copy, see Fig. 14. 
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Fig. 14. HSC print dialog for graphics. 

 

8. If you want to see the diagram in a tabular format or use the data of the diagram in 

other programs, such as MS Excel, press Table. 

9. You can copy the diagram to the Clipboard by pressing Copy, and paste the 

diagram to other Windows programs. The Copy command uses the Windows 

Metafile format, which enables you to resize the diagram in other Windows 

applications in full resolution. 

10. With Save you can save the diagram into a file using the Windows Metafile 

format. 

11. Press Axis to return to the previous Axis menu, Fig 10. 

12. Press Exit to return the Species window, Fig. 8, or to exit the PIC program. 
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13.7.3 Equilibrium Diagram Table 
 

 
 

Fig. 15. Equilibrium Diagram Table. 

 

You can display the equilibrium results in a tabular format by pressing Table the Axis 

menu, Fig. 10, or in the Diagram window, Fig. 11. The Table window has several Excel 

type features in a similar way to the other spreadsheets in HSC. The most important 

features are: 

1. With Copy All you can get the whole table into the Clipboard, and paste this table, 

for example, to MS Excel. You can also copy and paste smaller cell ranges using 

the Copy and Paste selections in the Edit menu, see Fig. 15. 

2. You can also save the table using different formats, such as ASCII text and Excel 

by selecting Save from the File menu. 

3. The Table window has two sheets. The Species sheet contains the data of the 

diagram; the figures in this sheet can be edited, if you are not satisfied with the 

results. The Format sheet contains the format specifications of the diagram. It is 

not recommended to edit the Format sheet. 

There are several formatting options in the Format menu, which can be used to create 

representative tables for printing. The table can be printed using the Print selection in 

the File menu, Fig. 15. There are also available options Setup and Preview for printing. 

The Axis button will open the Axis menu, Fig. 10, and Diagram will draw the diagram, 
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Fig. 11. 
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13.8 Non-ideal mixture: GaAs Example with Activity formulae 
 

 
 

Fig. 16. Input data of an activity formula example. 

 
  LOGf(1) =((1-X1)^2)*(-25503.6-4.3109*T+5174.7*(1-4*X1))/(8.31431*T) 

  LOGf(2) =((X1)^2)*(-25503.6-4.3109*T+5174.7*(3-4*X1))/(8.31431*T) 
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Fig. 17. Results as a function of arsenic amount. Different colors have been used for species, but these do 

not show up well in this B&W copy. 
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13.9 CaCO3 Example (Aqueous solution exists) 
 

 

Fig. 18. Input data of example CaCO3.IGI. 
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Fig. 19. Results as a function of added CO2(g). Different colors have been used for the species, but these 

do not show up well in this B&W copy. 
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Fig. 20. Results on logarithmic scale, the default example is shown in Fig. 19. 
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Fig. 21. Results as a function of pH, the default example is shown in Fig. 19. 
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13.10 Vapor Pressures 

HSC Equilibrium module may be used to calculate vapor pressures for substances. 

"VaporPressurePbS.igi" sample case is available in your \HSC5\Gibbs- folder, see Fig. 

22. It is made for PbS vapor pressure calculation. This case has been created with the 

same procedure as described in Chapter 13.1. Note that: 

1. Nearly all Pb- and S-containing species have been selected to the chemical system. 

2. Some nitrogen has been added to stabilize the gas phase. 

3. Some extra sulfur has been added to make the case easier to solve for Gibbs.exe. 

Usually this trick is not needed but it may be used just to be safe. 

4. Calculations are made from 0 to 2000 C°. 

5. Selection of 100 bar total pressure makes possible calculation of vapor pressure up 

to 100 bar. Total pressure 1 bar would give vapor pressures up to 1 bar. 

6. The equilibrium module calculates the equilibrium composition of the phases. In 

this case, the equilibrium composition of the gas phase. 

7. All gas species have been selected to the diagram in the species dialog, see Fig. 9. 

Do not select PbS ! 

8. "Equilibrium Composition"  has been selected to Y-axis in the Axis dialog, see Fig. 

10. 

9. The calculation results are shown in Fig. 23. The default Y-scale of the diagram is 0 

- 100 mol-%, but is has been changed to 0 - 2 mol-%. 

10. PbS(g) composition at 1330 C° is 1 mol-%. PbS(g) partial pressure is then 0.01, this 

means that PbS(g) vapor pressure is 0.01 * 100 bar = 1 bar, see Fig. 23. 

11. The total pressure of PbS is the sum of all the partial pressures of the gas species 

formed of PbS, ie. sum of: PbS(g), Pb(g), S2(g), Pb2S2(g), Pb2(g), etc. 

 

HSC 5.0 can not calculate the total vapor pressures automatically. However, this may be 

carried out, for example, in MS Excel. Press the Table button in the diagram menu (see 

Fig. 23) to see the diagram data in tabular form and use the Copy - Paste procedure to 

transfer this data to MS Excel. You may also save this table in Excel format. In Excel 

you may calculate the sum of all the partial pressures, see the VaporPressurePbS.XLS 

example in your  \HSC5\Gibbs-folder. 

 

HSC database reference Knacke 91 gives 1314 C° for PbS boiling point and Janaf 98 

gives 1320 - 1344 C° depending on the measurement or calculation method. These values 

are in reasonable agreement with the calculated PbS boiling point of 1327 C° in 

VaporPressurePbS.XLS. 

 

The gas phase above PbS contains mainly PbS(g). However, in many cases the gas above 

pure substances may be composed of many different species. In these cases it is 

important to note that the total vapor pressure is the sum of the partial pressures of all the 

different gas species formed of the evaporating susbstance (not N2(g)). 
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Fig. 22. Chemical system specification for PbS vapor pressure calculations. 
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Fig. 23. Results of PbS vapor pressure calculations. 
 


